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Software License  iii

Horticopia End-User Software License Agreement
This is a legal agreement between you, the "End User", and Horticopia, Inc.  If you install or otherwise 
operate and utilize the HORTICOPIA®  software (the "Software"), you agree to be bound by the terms of 
this agreement.  If you do not agree with the terms of this agreement, you are not permitted to install 
or otherwise operate or utilize the Software.  By opening the package containing the HORTICOPIA®

Professional V product media, you are agreeing to be bound by the terms of this agreement.  If you Professional V product media, you are agreeing to be bound by the terms of this agreement.  If you Professional V
do not agree with the terms of this agreement, promptly return the entire unused product to your 
place of purchase for a refund.

License Agreement
Horticopia, Inc. grants to you and you accept a nonexclusive license to use the programs and related 
materials delivered with this AGREEMENT as follows:

The Software, digitized photographs, digitized audio, plant data, supporting documentation, and 
related materials are copyrighted with all rights reserved.  They are protected by copyright laws and 
international copyright treaties, as well as other intellectual property laws and treaties.  You may not 
copy the Software or other materials on the accompanying compact disks, in whole or in part, without 
the written consent of Horticopia, Inc., except in the normal use of the installation and backup of the 
Software.  The Software may be installed only on one computer and used by one user at a time. Use 
on a network for access by  multiple concurrent users requires additional licensing from Horticopia, 
Inc.  The copyright extends to all pictures and data printed, exported or otherwise derived from this 
HORTICOPIA®  product.

If you discover physical defects in the media on which the Software is distributed, Horticopia, Inc. 
will replace the defective media at no charge to you provided you return the defective items, with 
proof of purchase, within ninety (90) days of the date of purchase. Horticopia, Inc. makes no other 
warranties.  Horticopia, Inc. disclaims all other warranties, either express or implied, including but 
not limited to, implied warranties of merchantability or fitness for a particular purpose with respect to 
the Software and the accompanying materials, if any.  This limited warranty gives you specific legal 
rights. You may have others which vary from jurisdiction to jurisdiction. The warranty set forth above 
is in lieu of all other express warranties whether oral or written. Agents, employees, distributors, and 
dealers of Horticopia, Inc. are not authorized to make modifications to this warranty, or additional 
warranties on behalf of Horticopia, Inc.
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Introducing HORTICOPIA® Professional V

This chapter provides information on system requirements, installation, licensing and removal of 
the Professional V.  You will also learn how to run the program and where to get additional help with 
the Professional V.

Welcome to HORTICOPIA®

HORTICOPIA® Professional V is the most comprehensive on-line multimedia reference available for 
horticultural information.  The collection of pictures, ease of access and rich features found in the
Professional V edition will make HORTICOPIA® your standard in interactive horticultural reference.

If you are familiar with other Microsoft® Windows® ( 10, 11, server 2012, 2022) applications, then 
learning to use the Professional V effectively will be very straightforward.  The Professional V uses 
common Windows conventions including menus, toolbars, lists, and multiple windows.  The Profes-
sional V is a full-featured program that provides in-depth coverage and flexibility.  Please spend a 
few minutes familiarizing yourself with its basic operations and you’ll be on your way to getting the 
most out of the Professional V.

The Professional V program itself, help files, supporting data files, and library files are copied to your Professional V program itself, help files, supporting data files, and library files are copied to your Professional V
hard disk during setup.  On most Windows systems, simply inserting the HORTICOPIA®  Flash Drive
(HFD) will start the Installation program.

System Requirements

Your system must meet certain minimum requirements before you install and run the HORTICOPIA®  

Professional V.  The accompanying table summarizes these system requirements.  Successful instal-
lation does not guarantee that your system meets the requirements necessary for running the Profes-

sional V. If  you are running in a user access controlled environment, you must have Administrative Privileges 
to install the software. 
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Installation of the Professional V requires approximately 20 gigabytes of hard drive space, including the 
core Professional V image library.  The amount of space required varies depending on what system com-Professional V image library.  The amount of space required varies depending on what system com-Professional V
ponents such as Microsoft Dot Net Framework, Microsoft SQL Server, and supporting runtime libraries 
are already present on your system.  If you have a network, storage requirements are minimal for a client 
installation after installation of the server version. 

The following table provides the size (in megabytes) for each of the picture/portfolio libraries:

Professional V 7,390

Woody Plus Library 2,904

Herbaceous Plus Library 1,033

Aquatics and Marginal Plants Library 170

Japanese Maples by Francine Schroeder 460

Interior Plants Library 137

Armitage Herbaceous Selection Port. 1,120

Portfolio of Herbaceous Plants, Vol.1 456

Portfolio of Woody Plants, Vol. 1 1,537

You may install the Professional V Libraries and Portfolios in a folder other than on the same disk drive 
as the software if you have more space on another disk drive.  You may also install the Professional V
Libraries and Portfolios on a network disk drive.  Simply restart the installation, select the components you 
wish to install, and choose a different path when you run the installation for the Professional V with the 
HFD.   Besides hard disk storage, you may access the Professional V Libraries directly from the HFD or a 
shared USB drive anywhere on your network.  After installation, the Professional V Plant Library Locator 
(accessed from the Professional V Control Panel’s Setup Tab) controls the location of the libraries and 
portfolios.    The software will also run without the library images loaded at all; however, you will get 

System Requirements Recommended

Operating System Windows® 11, Server 2012, Server 
2022

Main memory (RAM) 4 GByte or more

Hard disk space 20 GBytes of available hard disk space, 
plus space for extra libraries as shown 
below.

Mouse or other pointing 
device

required

Video adapter
Display of 65536 colors or more 

Monitor 1024 by 768 screen resolution or more

Windows compatible sound 
card/subsystem

Optional, required to hear botanical 
names and background music

Printer Optional, although a printer driver must 
be installed even though no physical 
printer is required 
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an “unavailable picture” displayed whenever the Professional V  Professional V  Professional V cannot locate the appropriate image. To 
avoid unavailable pictures, all library images must be accessible on-line in the locations shown in the 
Professional’s Plant Library Locator when the software is executed.  

Installing the Professional V 

IT IS RECOMMENDED THAT YOU TURN OFF ANY VIRUS CHECKING SOFTWARE BEFORE STARTING INSTALLATION.

Most Windows drives support Autoplay.  Simply insert the HFD in a USB port and the Professional V
setup program should start in a few seconds depending on your Autoplay settings.

If the automatic start-up of Installation does not work on your configuration or causes a problem, you 
may install the Professional V as follows:

1. From your taskbar’s Start button, select Run…

2.    Enter x:\Setup and substitute the appropriate drive letter where the HFD is mounted for x:.
3. Click on OK

When the installation first starts, you will be presented with the W������ screen.  

N���: Allow sufficient time for the installation to complete.  
Depending on the speed of your computer and the status of 
the installed supporting Microsoft software, installation may 
take from 5 to 30 minutes or more. 

For new installations, you will first be prompted to choose a standalone or network (server) installa-

tion.  

Unless you have purchased a HORTICOPIA networking license, select STANDALONE.  For network instal-
lations, refer to the Networking Guide.
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After some preliminary runtime routines are installed, you will be presented 
with a screen asking you to enter your HORTICOPIA product number.  This 
number was either included in the product shipped to you or communicated 
to you by your seller.

EXISTING USERS: If you are updating the software or have previously installed 
the Professional V, then your HORTICOPIA Product Number will already be 
filled in. Verify that it is still the same or make appropriate corrections.  If you 
are upgrading the software or libraries, then the values of the first two fields 
will have changed from the previous installation.  If the installation software 

detects a previous version of HORTICOPIA®  Professional, you will be prompted to choose between 
doing a new install or an update.  It is highly recommended that you select update.  This will permit 
you to easily migrate your data and to minimize the steps needed for product authorization.

     

     For most installations, you can simply use the defaults 
and click NEXT. 

     If you wish to select a different destination, click on 
the BROWSE button and select a new destination.  Note 
that Horticopia is always appended to the destination 
folder you select.  

     If you do not want to install in a subfolder called Horticopia, be sure 
to delete the appended Horticopia shown as highlighted in the screen 
image below.
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Based on the Product Number entered, you will receive a confirmation about the libraries and portfolios 
to be installed.

You may check or uncheck the selections to override the library/portfolio 
selections made for you based on the product number.  Note that, without 
authorization codes from Horticopia, installing additional libraries will 
simply take up more disk space and be of no benefit.

If you want to install the libraries in a folder different from the default folder, uncheck the library names 
and rerun the installation with only the names checked for the libraries/portfolios to be installed.

When the installation is complete, you will receive a completion dialog.
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Starting  the Professional V for the First Time

IT IS HIGHLY RECOMMENDED WHEN YOU START HORTICOPIA 
THE FIRST TIME - RUN AS ADMINISTRATOR
On your desktop, click with the RIGHT mouse on the Horticopia Pro icon V, 
then when the drop-down menu appears, click on Run as administrator. 

  

After starting the Professional 
V, you will get a display about 
your authorization options.  See 
the screen at the left.

At this point, you may click on 
the SKIP button to proceed with 
running the Professional V. Until 
you authorize the Professional V, you will not be able to copy 
pictures from the Professional V to other applicationsProfessional V to other applicationsProfessional V .

       

       If you have not installed the Professional V Libraries  Professional V Libraries  Professional V or any additional picture volumes (from a flash 
drive or online) and want to see the pictures, you must quit HORTICOPIA® Professional and complete 
the installation of those picture volumes.  This can be done with the installion of the Professional V  Professional V  Professional V
setup as previously described.  

Normally, the dialog box to the right does not appear if you 
installed all the picture libraries.  If you do get this dialog and 
have installed all of your picture libraries, choose LAUNCH 
HORTICOPIA CONTROL PANEL so you can specify the location of 
the picture libraries.

The HORTICOPIA Ad-
visor option will appear the first time you run the Professional V.  
To speed the learning process of the Professional V main features, 
new users are encouraged to enable the Advisor.  You can use the 
Help menu options to control the presence of the HORTICOPIA 
Advisor topics.  
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Starting the Professional V after the First Time

The Professional V is normally started by double-
clicking on the HORTICOPIA Pro icon placed on 
your desktop during installation.  If you delete this 
icon or if it’s not visible, you may also start the Pro-
fessional V from the START menu by selecting ALL 
PROGRAMS and then HORTICOPIA PRO V, followed by 
HORTICOPIA PRO.

We strongly recommend that you frequently access 
https://www.horticopia.com/support for more in-
formation on the Professional V.  Here you will find 
updates that correct any problems discovered after the 
production of the software media, as well as FAQs, 
technical memos and on-going enhancements to the 
capabilities of the Professional V.

Licensing

Until the Professional V is authorized, you will get the licensing screen (shown below) each time you start 
the program.  The top of the screen shows you how many 
days you have left to obtain your authorization.

The most convenient way of obtaining your Authorization 
Code is to use the INTERNET request option.    If you don’t 
have Internet connection, select the FAX, MAIL, OR TELE-
PHONE option.  The required information will be gathered 
automatically and placed into a format ready for faxing, 
printing, or mailing.  You can also attach the information 
to an e-mail you generate yourself on another computer.  
With the exception of the ability to export pictures, you 
will have all the features of the Professional V available Professional V available Professional V
even prior to authorization.  This allows plenty of time for 
the authorization process to be completed.

IMPORTANT: With your purchase of the Professional V, Professional V, Professional V you 
received a unique Product Number.  The Product Number will normally be on a separate folded insert 
with your product and clearly identified as your Product Number.  In some cases, you may have received 
the Product Number separately (by mail or telephone) when you ordered the product.  
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If you choose the recommended INTERNET option, you 
will be prompted to fill out the information as shown 
in the screen shown to the right.  For e-mail or fax, 
you will be presented with the screen shown below.

The Product Number is required to complete the 
authorization process.  It is pre-filled in the form 
from the information you supplied at installation time.  
Double-check to make sure it is correct.  It identifies 
the Professional V libraries/portfolios and features you Professional V libraries/portfolios and features you Professional V
purchased.  We cannot provide an Authorization Code 
without a valid Product Number.

Please fill in all the required fields.  We have provided 
space for your normal e-mail address if it is different from 
the one where you wish to receive your Authorization 
Code.  Make sure your e-mail address is correct and, 
if faxing, fill in the fax number where we will fax your 
Authorization Code.  

Your information will be kept private, because Horticopia, Inc. 
will neither sell nor give away your address to third parties for their 
solicitation purposes.  We do however, keep our registered users 
informed of  new products, discounts and free updates.

If you clicked Submit on the Product Information form 
and chose the Fax, Mail, ... option, you will receive a 
printable output ready to fax or mail to Horticopia, Inc.  
You may also use this form to have all the information 
handy for telephone authorization.  If other windows hide 
the Notepad window,  look for it on your taskbar.
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If you selected the INTERNET registration, you will receive a confirmation message that your authorization 
request was successfully transmitted.

To FAX the information, use the Notepad’s File 
menu Print command to print it out first or use 
your computer’s built-in fax capabilities.  To 
mail in your authorization request, simply print 
the file (File menu, then Print) and mail it to 
Horticopia, Inc.

Whether you use INTERNET, FAX or MAIL, the next 
time you run the Professional V, Professional V, Professional V you will be 
prompted to enter your Authorization Codes.  

If you have not received them, simply click on the 

C����� button.  Once you have received your Authorization 
Code, enter it in the spaces provided.  NOTE FOR WINDOWS 10 
AND 11 USERS: You must have administrative privileges to authorize 
the program.  Once authorized, you normally do not need administrative 
privileges. Double-check the entry to make sure it’s correct and 
then click on OK.  You’ll get a confirmation of successful 
authorization.  In the future, you will get no more authoriza-
tion screens when you start the Professional V.

The R�-��������� button is used only when your Authori-
zation Code has gotten lost or if you incorrectly entered the 
Authorization Code several times.

Transferring Professional V to Another Computer

There may arise a situation where you wish to transfer Professional V to another computer.  To do this, 
you must also transfer the license.  To transfer the license, you will have to terminate the license on the 
computer with the existing copy of HORTICOPIA®  Professional V.  After terminating the license on this 
computer, you will receive a termination code that will be used for reauthorization.

To terminate the license (Note: after terminating the license, the program will no longer function), open 
the HORTICOPIA®  Professional Control Panel. Or in Professional V,Professional V,Professional V  click on TOOLS and then LAUNCH CONTROL 
PANEL to access the Control Panel.  In the Control Panel, click on the LICENSING tab, then click the button, 
TERMINATE LICENSE.   Click on PROCEED WITH LICENSE TERMINATION.  After the message: “Are you sure you want 
to terminate the HORTICOPIA® Professional V license on this computer?”, click YES to obtain your termina-
tion code.  Record your termination code and click CLOSE to exit the program.  You can now uninstall the 
HORTICOPIA® Professional V software from this computer using the Windows Control Panel’s Add/Remove 
programs.  

IT IS VERY IMPORTANT THAT YOU DO NOT UNINSTALL THE PROGRAM PRIOR TO TERMINATING THE LICENSE.DO NOT UNINSTALL THE PROGRAM PRIOR TO TERMINATING THE LICENSE.DO NOT
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For more information about license termination, go to our Knowledgebase pages at : 

https://www.horticopia.com/hesk/knowledgebase.php  and search for ‘terminate’. 

If you are upgrading your computer with major hardware changes, such as replacing the motherboard or 
replacing the primary (boot-up) hard disk drive, you should also follow the license transfer procedure.  
Please contact Horticopia Technical Support prior to commencing with the upgrade.

Multiple Computers

If you have purchased the networking option, you may install the Professional V on a networkable com-
puter and then run it from other computers on the network.  However, only one user at a time may run 
the Professional V unless you purchase additional network user licenses. Please see the Professional V
Network Guide for more information.Network Guide for more information.Network Guide

If you need to run the Professional V on multiple computers that aren’t networked, you may purchase 
additional licenses at a discount

Disk Crashes

If your hard disk crashes and you restore it, the Professional V will normally run properly.    If you experi-
ence problems running the Professional V after a disk crash, you should reinstall Professional V. 

Working with the Plant Library Manager (HortPro Control Panel)

Normally, all of the picture Libraries used by the Professional V will be in the same folder, HortProfPix.  
Typical picture Library names are R1, R2, R3, H3, W4, A1, A2, etc.   

When you installed the picture Libraries, you could have selected a different location.  You should browse 
to the HortProfPix folder or to the folder containing HortProfPix folder or to the folder containing HortProfPix HortProfPix.  If the libraries are not in a folder named 
HortProfPix, you’ll have to browse to the specific folder where they’re located.HortProfPix, you’ll have to browse to the specific folder where they’re located.HortProfPix
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Running on a Network  (Optional Module)

If you have the optional Network Module with the Professional V, Professional V, Professional V you can easily run it on a Windows 
network.  The networking license for the Professional V is a floating network license, which allows ONE 
user to run the Professional V anywhere on the network.  Once that user signs off, another user can sign 
on.  If you require additional concurrent users, please contact Horticopia sales to purchase additional 
user licenses.

Networking Plus (Optional Module)

Networking Plus is an optional feature that in addition to the full license,  several clients are added in a 
read-only mode of accessing HORTICOPIA® information.   

Authoring Module (Optional Module)

Authoring  Module is an add-on to the Professional V that allows you to add your own plants to the 
PProfessional V's  plant list.  You can add your own plants, data and pictures to your authored plants as 
well as add/change pictures and data to Horticopia plants.

Garden Studio® (Optional Module)

The HORTICOPIA® Garden Studio®  module is a tool for designing and producing custom data sheets for 
plants as well as ancillary materials such as garden center hard goods.

Garden Studio® works in conjunction with HORTICOPIA® Professional V, giving you access to information 
on thousands of plants along with tens of thousands of pictures. Although you can readily design and print 
in the Professional V, you are limited to creating the data sheets and point of sale material for one plant 
at a time. With Garden Studio®, you create a design for your data sheets and point of sale material just 
once; then print them for any number of plants with all the plant specific information, including pictures, 
information, price and UPC symbols automatically filled in the exact spot you have designed.
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Getting Started with the Professional

In this chapter, you will learn how to perform some of the common tasks in the Professional V.  Spending 
a few minutes reading this chapter will put you on the fast track to being a proficient Professional V
user.  If you are already familiar with previous HORTICOPIA® products, you may wish to get started with 
the software right away and consult the appropriate on-line Help topic when you encounter a new or 
unfamiliar feature.

It is important to note that the Professional V supports two types of plant records: Libraries and Portfolios.  
Plant records that contain plant pictures, plant data and botanical pronunciations are provided to you as 
part of a library, part of a library, part of a library such as the Woody Plus Library.  Plant records that contain only pictures and no plant data 
or pronunciations are packaged and provided to you as part of a portfolio, such as the Armitage Herbaceous 

Collection.  Some of the features covered in the subsequent sections and Quick Tours require plant data to 
function properly and do not apply to users that own only Professional Portfolios.

Special Notes for Portfolio only users

Portfolios contain only pictures.  These pictures are cataloged by Botanical name, Common name, Plant 
family and Plant type.  Searching for a plant using its nomenclature or plant type in Professional V is fully 
supported.  Other search criteria such as hardiness, bloom time or moisture requirements are disabled 
because there is no data to support the search.  If you choose to add your own data using the optional 
Authoring Module, the selection criteria will function for those authored plants.  Plants without data, 
however, will not be included in your search.

Professional V supports printing of both pictures and data in a variety of formats.  Because Professional 

Portfolios contain only pictures and nomenclatural information, there is limited value in printing a data 
sheet or copying a data tab to a layout.  These features are still functional in the event that you wish to 
add your own data using the optional Authoring Module.

HORTICOPIA® Concepts

The Professional V is a “standard” Windows® software application.  If you’ve worked with other Windows®

programs such as word processors, spreadsheets, or graphics design packages, then you will already be 
comfortable with many of the aspects of the Professional V.

Nomenclature

The HORTICOPIA® Help contains an extensive glossary of terms used in the Professional V.  There are a 
few unique terms and usages within the software that will help in understanding the remainder of this 
chapter.

Garden Workbench®:  the central work area or window for HORTICOPIA® Professional, frequently 
shortened to Workbench.
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Botanical Names:  the plant lists contains both new names and synonyms (names that appear in 
gray font).  The primary sources for nomenclature are the New Royal Hor ti cul tur al Society 
Dictionary of Gar den ing and Hortus Third.

Collections:  a selectable list of the HORTICOPIA® libraries and portfolios purchased with the Profes-
sional V . sional V . sional V

Favorites:  patterned after the popular Microsoft Internet Ex plor er® feature that makes available 
a central location on the Workbench where you can store and quickly access frequently 
used items. 

MyList®:  plant names that have been designated by the HORTICOPIA® user as being special; MyList®

plants have a check mark in the box next to their name.

Filtering:  the process of displaying only some of the available plants in the list; filtering may be by 
MyList®, Hardiness zone, or other selections.

Layout:   the composition of pictures, graphics, data and text created by the user with the intent of 
printing.  Also known as Print Layout.

Preferred Picture/Second Preferred Picture:  the picture(s) designated as representative of the 
plant whenever several pictures are present; The Preferred Picture appears at the ��� ����
of the plant’s preview pictures and the Second Preferred Picture appears next to it.

The Garden Workbench®

The heart of HORTICOPIA® Professional V  Professional V  Professional V is the Garden Workbench®.  From here, you’re just a couple of 
clicks away from getting the information you need for any of the plants in the Professional V  Professional V  Professional V libraries.  
You can search for plants, select plants of interest to you, create lists, compare pictures from different 
plants, hear the botanical names pronounced, print lists/data/pictures, indicate Favorites, switch between 
common or botanical names, and more.

The illustration on the next page shows the Professional V Garden Workbench® annotated with circled 
key numbers identifying important areas.  

Plant data and botanical pronunciations are not included in Professional V PortfoliosProfessional V PortfoliosProfessional V . The S���� Button 
and the A�������� Button will be marked as unavailable if selecting a plant record only contained in a 
Professional V PortfolioProfessional V PortfolioProfessional V .  The Exposure, Hardiness, Soil Type and Soil pH Graphics will not be available 
to Portfolio users unless they have added data using the optional Authoring Module.
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1. Information Button  -- displays the Information window for the plant name highlighted in the 
plant list

2. Sound Button -- provides audio pronunciation of the botanical name of the plant highlighted in the 
plant list

3. Attribute Button -- outlines the graphics in the main plant selection area as well as in the tab areas 
with a green border to reflect the characteristics of the plant highlighted in the plant list.  This provides 
a graphic view of the plant’s characteristics and lets you quickly find similar or compatible plants.

4. Thumbnails Button -- displays Thumbnail views of the plants highlighted in the plant list.  If no 
plant is highlighted, all plants in the list will appear in the Thumbnails view.

5. Switch Names Button -- changes the list between botanical and common names.
6. List Counter -- displays the number of plants currently displayed in the list.  The counter is updated 

as you perform plant selections.
7. MyList® Button -- alternately shows the plants on MyList® or displays all the plants.
8. MyList® Counter -- displays the number of plants currently on the MyList®.
9. Clear Button -- resets the plant list.  Any hardiness and plant type screening in effect remains and 

will affect the contents of the list.

10. Woodies Selection -- displays only woody plants and the woody selection window is presented.
11. Herbaceous Selection -- displays only herbaceous plants and the herbaceous selection window is 

presented
12. Exposure Graphic -- select plants based on light requirements, an important environmental criteria 

for plant performance 
after Hardiness. 

13. Hardiness Graphic -- 
select plants based on 
USDA zones

14. Soil Type Graphic -- select Soil Type Graphic -- select Soil Type Graphic
plants based on soil 
requirement.

15. Soil pH Graphic -- 
select plants based on pH 
requirements.

16. MyList® indicator -- a 
check adds the plant to a 
MyList®

17. Search indicator -- enter 
text to search plant list 
names.
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The ABCs to Seeing Plant Information

·   Locate the name of the plant by scrolling to the name or just entering the first few letters of the 
name.  

.   The yellow folders next to some plant names signify that a species has more than 
one cultivar.  Click on these folders or the plus sign (+) to see the cultivars .

·   Click once on the name of the plant you want so it’s highlighted.
·   Click the  I���������� button, or double-click on the plant name.

·   Double-click on a preview picture to view an enlarged picture or single click on one of the other tabs 
to view data.

Managing the Plant Lists

Using the Workbench plant list, find plants, create your own lists, refine plant searches, and see plant 
names in different arrangements or naming conventions.  
 ·  Adjust the plant list’s appearance with the Tools menu item, CUSTOMIZE.  Click the WORKBENCH tab to 

set the font type and size, as well as the default expansion level of the plant list to Show all Plants or 
to Show all Cultivars.  You may also group the plant list by families instead of alphabetically.

·   Switch between botanical names and common names at any time by clicking the Switch Names 
button.

    The gray names shown in the botanical name list are synonyms and clicking on them will carry you to 
the current name. 

·   You’ve probably already discovered that you can select a plant name by clicking on it once.  You can 
also select several plant names by holding down the CTRL key while selecting them.  Holding down 
the SHIFT key selects all the plants from the first selected one through the one you’re currently pointing 
to.  Multiple plant selection is useful in printing plant lists, creating Slideshows, viewing only selected 
plants and working with your own plant lists.

·   Enter the first few letters of a plant name, and the plant list will jump to the first entry beginning with 
those letters.  

·   There are also several shortcut keys you can use with the plant list.  Press F1 while you’re on the 
Workbench and look for “Keyboard Shortcuts.”

·    Search the list for specific words or even portions of words using the  FIND feature  on the Workbench  
toolbar.

   About MyLists®

You can designate plants to be on your own special list, which can be saved and re-opened at a later time.  
In HORTICOPIA® , this list is called MyList® and you can have as many lists as you wish.  

 plant list, find plants, create your own lists, refine plant searches, and see plant 

set the font type and size, as well as the default expansion level of the plant list to Show all Plants or 

to.  Multiple plant selection is useful in printing plant lists, creating Slideshows, viewing only selected 

 on the Workbench  
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Add or remove a plant on the MyList®  by clicking the box next to the plant name.  When a plant is added 
to a MyList®, a check will appear in the box  next to the name.  

Each time you add or remove a plant on a MyList®,, the counter below the M�L���® button  
will be updated ( item #8 on the Garden Workbench® graphic).  

Add several highlighted plants to MyList® by clicking  on the toolbar.  The entire list (usually after 
a search) can be added by selecting Add All to MyList® from the Selections menu or 

 on the toolbar.  The entire list (usually after 
 from the 

toolbar.

Save each MyList® with the File menu Save MyList selection.  The Open menu lets you load previously 
saved lists.  The names of the most recently saved or opened MyList® files appear at the bottom of the 
File menu.

Working with common names - you may notice that when a plant name is selected, other names appear 
as grayed text.  These are additional common names, or aliases, of the common name you selected.  Once 
you add a common name to MyList®, the name you chose becomes your preferred common name.  When 
you then display the MyList®, you will see only the preferred names you have selected.  

Clicking the MYLIST® button alternately shows only the plants on the MyList® or all the plants currently 
on the list.

Rearranging the plant name order - When viewing only the MyList® plants, you can rearrange the order 
of the plant names by first selecting a name or names and then holding down the Alt key and clicking in 
the list where you want to move the names.  A red line indicates where the moved items will be placed 
when you release the mouse.
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Quick Tour 1 — Searching for a Plant
Special Note:  Plant data is not included in Professional Portfolios and searching is limited to Nomenclature and Plant type.    

Searching for a Plant Name

1. Enter the first few letters of the plant name on your keyboard

2. Enter the plant name  in the search field at the bottom of the plant list.

Displaying Plants in the Plant List Based on Characteristics

1.   Expand your plant list so all plants are available. Right click the Clear button and select Clear all 
selections.

2.   Set a hardiness zone of 8b by clicking on the rectangle next to the number 8 on the hardiness chart.

3.   Click on the Woodies or the Herbaceous selection.

4.   Click on the yellow bloom petal.  As you click on these plant characteristics, note the counter below 
the 
Click on the yellow bloom petal.  As you click on these plant characteristics, note the counter below 

 button.  It shows the number of plants that match your current search specifications.  The 
plant list updates automatically each time you make a plant characteristic selection.

5.   Select a plant height and then a leaf color and note with each selection the plant count changes.  

6.   Continue clicking on graphics until the plant count is about 50.  

Using the Thumbnails View

1.   Once you have about 50 plants in the plant list, click on , the T��������� button. You will get 
a Thumbnail window that shows the first picture of each plant in the list.  

2.   Enlarge the Thumbnails window by clicking on the M������� button at the upper right corner of the 
Thumbnails window.



18                                                                                                                        HORTICOPIA® Professional® Professional®

Quick Tour 2— Printing Data, DataPlus, Picture, and List Sheets

Begin by selecting about six plants and put them on a MyList® by clicking(checking) the box next to the 
plant name.

Setting the Preferred Pictures

1.   Click the M�L���® button.  There should be six (or so) plants showing in the list.

2.   Click on  the I���������� button to view the preview pictures for the first plant.

3.   The Professional V  Professional V  Professional V uses the top left picture as the Preferred Picture for Data, DataPlus, and Picture 
Sheets.  You can change the Preferred Picture by selecting the picture you want, then drag and drop-
ping it on the top left preview picture.  The picture will then be moved to the first position.  This 
positioning will be remembered even if you quit and restart HORTICOPIA.

4.   To get to the next plant in the list, Press the F5 key, Select the Data menu and click Next Plant or

        Click  on the Data toolbar.   

5.   Repeat Steps 3 and 4 until all the preview pictures have been arranged so that your preferred picture 
is the top left preview for each plant.

Getting Ready for Printing and Printing the Pictures

1.   From the File menu, select Document Setup...  When the Document 
Setup window is displayed, click the Pictures tab to control the format 
and layout of the picture sheets.

2.   Make your preference selections similar to the illustration at the right 
with 6 pictures per page selected, then click OK. 

3.   Verify that no plants are selected in the list.  You can click on the 
C���� button to make sure.. 

4.   From the File menu, select Print-, Print Pictures.  You will get a 
printout of the pictures you placed in the top left position of each 
plant.

     Special Note: Data and DataPlus Sheets can be printed in the same manner as Picture Sheets. 
Create a MyList® and select your Preferred Pictures. From the File menu, select Document 
Setup...  to display the Document Setup window.  Click on the Data or DataPlus tab to control 
the format and layout of the data sheets.  From the File menu, select Print-, Print Data or Data-
Plus to get a data sheet for each plant based on the selections you made.

     More detail at Document Setup Quick Tips at 

       www. horticopia.com/documents/documents.html.
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Quick Tour 3 — Creating a Simple Layout

Create a customized layout containing pictures and information.  The first step in designing your layout 
is to specify its size and page orientation  

From the File menu, select Document Setup and review the Layout tab settings.  Or use  the D������� 
S���� button at the top of your tool bar.  Verify that the page size and orientation as these settings need 
to be made first before creating the layout.  All other settings in the Document Setup window can be 
changed after the layout has begun.

Adding a Plant Picture to a Layout

1.   Begin by selecting a plant from your list and double-click on the name to bring up its Plant Information 
window.  The tabs are shown below.

     Your layout can include any of the pictures and text found in the Plant Information window (except 
Scratch Pad, Spreadsheet, optional Garden Studio tab and the Added Notes tab).

2.   To select a plant picture, click once on the image and a green frame will appear.  Single click on 
the C��� �� L����� button on the Data toolbar to the right of your screen.

3.   The layout window will appear.  The toolbars that used for layout design  are shown undocked 
below.

     



20                                                                                                                        HORTICOPIA® Professional® Professional®

Using the cursor , click the mouse button and drag a box to place your picture in the layout. You can 
resize the picture by dragging the boxes in the corners of the picture. 

Suggestions:  Suggestions:  Suggestions: Add a frame around your picture using  the 
Line tool  found on the Design Control toolbar.  

With the picture selected, click on the triangle and select the desired 
border line size.  

Use the Design Control toolbar tools to change the fi ll color for an 
item , add a shadow to an item , add a shadow to an item  and even change the 
color of  the shadow.

Other pictures may be added to your layout by min i -
miz ing the Layout window and making another selection 
using the same steps mentioned above.

Adding Text, Graphics and Pages to a Layout

1.   Add text to your layout from other tabs on the Plant Information window (except the Scratch Pad, 
Spreadsheet, optional Garden Studio tab and the Added Notes tab).  Using the same procedure as 
when adding pictures, with the information tab open, click on 
Spreadsheet, optional Garden Studio tab and the Added Notes tab).  Using the same procedure as 

 the A�� �� L����� button.  Then 
drag a box as before to add the information to the layout.

2.   A text box can be added to your layout to include your own information, such as company name, 
customer name, etc.  The I����� T��� B�� button 
A text box can be added to your layout to include your own information, such as company name, 

 is found on the Designer toolbar.  You also 
can use the I����� G������ button found on the Designer toolbar to insert your own images or 
graphics.  Additional pages can be added to your layout using 

 button found on the Designer toolbar to insert your own images or 
the I����� P���� button  found on 

the Pages toolbar.  To move between the pages of your layout, click on the P������� P��� and the Pages toolbar.  To move between the pages of your layout, click on the 
N��� P��� buttons located on the Design Pages toolbar.

Printing
1.   You’re now ready to print!  
2.   From the File menu, select Print Layout.
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Quick Tour 4—Creating a Master Page for your Documents

Create Master Pages for your Data, DataPlus, Picture and List documents to give them a very custom 
look.  You can have as many Master Pages as you wish and can designate different Master Pages for 
each type of document.

Creating a Master Page

1.   Open a blank layout by clicking on the Window menu and select Layout Window.  The Layout window 
will appear along with the Format toolbar and the Designer, Design Control and Design Page toolbars 
docked at the right of the screen.

2.   From the Designer toolbar, click on the ruler bar and drag guides to show the margins for your 
document.    Since the program will print the document within the margins, you will want your Master 
Page image between the margins and the edge of the paper.  

           

3.   Using the example below, add  a text box for company and client name, as well as graphics.    

4.   Save the design as Master Page for Data.

5.   Under Document Setup for the Data sheet, click on S�� D��� S���� M����� button and browse to 
Master Page for Data and click Open then OK.

6.   Select any plant by single clicking on the name, click on the P������ button and click on preview 
data.  The Master will appear on each page of your Data Sheet document.  
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The Authoring Module (Optional)

With the Authoring Module,  you can add pictures, data and new plants to HORTICOPIA® Libraries and 
change data for the HORTICOPIA®   plants.  You may also create new plant families and add your own 
botanical name pronunciations for plants and families you have added.

Authoring Components

There are several information components to each authored plant and when authoring, it is important 
that all of these information components fit together properly.  The components are nomenclature, 
pictures, attributes and data.

Nomenclature    

The nomenclature window includes family name, botanical name (species, subspecies, etc), cultivar 
name (if any), common name(s), family and sound. Each plant must have a botanical name and at least 
one common name.  A cultivar name is optional and, if omitted, “species” is assumed. Common names 
must be unique for a species, but authored common names may repeat common names provided in the 
Professional V database.  If a common name contains a comma (,), then the portion after the comma 
will be generated with the portion before the comma in addition to the full name.  For example, Maple, 
Red will generate Red will generate Red Red Maple in addition to Red Maple in addition to Red Maple Maple, Red.Maple, Red.Maple, Red

If the family doesn’t already exist, you may add a new family.  Both a common and botanical family 
name are required.   

When you create a new plant name, you may specify an appropriate sound file.  Windows “wav” files as 
well as “mp3” files can be used.  A sound file is not required to add a plant or family.

Pictures 

You may copy pictures from other HORTICOPIA® plants or you may add your own.

Attributes

Attributes define the plant’s selection criteria.  Examples are height, spread, bloom color, and leaf shape. 
You may edit the attributes for plants that you author. The hardiness that you specify will cause the ap-
propriate range map to be included.

Data

When you first create a new plant or make a name change to an authored plant, Professional V  Professional V  Professional V automati-
cally generates the nomenclature information on the Information tab.  This information is not changed 
if you make global changes (such as changing a species spelling).  Other data fields may be copied and 
pasted from other plants in the Professional V and then edited to suit your needs.  You may also enter all 
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information from scratch, but pasting from other plants in the Professional V  Professional V  Professional V will help in maintaining a 
consistent format.

Quick Tour 1 - Add a Plant, Pictures, Data and Search Attributes

Step 1 - Add a Plant Name

1.   In the plant list, rightright-click on Hypericum calycinum (or select another plant).  From the popup menu, 
click Add new plant...  In the resulting Add a new plant window, you can see that the botanical and 
common name fields are pre-filled with the names for the plant on which you right-clicked.  

2.   Click on the A�� button.  This creates 
a new plant on the list with the same 
name as the original plant with one 
slight difference: a ° degree symbol 
is appended to the name to show that 
it is an authored plant.  In addition, 
the search selection attributes of the 
original plant, as well as the growth 
zone, are displayed and can be edited 
at this point. 

     Reminder: Since Professional Portfolios do 
not contain plant data, Portfolio users will need to manually add search selection attributes.

Step 2 - Adding/deleting Plant Attributes

1.   You can add or delete search attributes by clicking on any of the graphics.  Click on the red petal of 
the bloom to add and then click on the yellow petal to delete the yellow color for bloom.   Click on 
Shrubs to add and then click on Groundcovers to delete as a plant type.  You can add/delete any of 
the graphics in this manner.  

2.   When you are finished modifying the attributes, click on the green A��������� button to set 
the new attributes and bring up the Plant Information window.

Step 3 - Adding Pictures

1.   After the Plant Information window appears, right-click in a blank area of the Preview tab, then select 
Paste Pictures.  The pictures from the original HORTICOPIA®  plant have been added to your plant.  ( It 
is not necessary to have a picture to continue the authoring process.) 

2.   If you wish to add pictures from other existing plants, you can browse to that plant, double-click on 
the name, then right-click in a blank area of the Preview tab.  A popup menu will appear with Copy 
All Pictures as one of the entries.  Left-click on Copy All Pictures and then close the Information 
window.  Click on the information window of your authored plant, right-click in a blank area of the 
Preview tab, then select Paste Pictures.  The pictures from the HORTICOPIA®  plant have been added to 
your plant.  
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3.   You can also add in your own pictures by dragging and dropping a picture(s)from your hard drive 
onto the Preview window.  Delete a picture by right clicking on the picture, then clicking Delete 
picture on the pop-up window. 

Step 4, Last Step - Adding Data

1.   Click on the Information tab and review the data generated from the graphical search attributes 
previously set.  

2.   Click on the Contributed Data tab and you can enter your own data or paste the data from the 
original plant tab by right clicking on an empty area in Culture Notes.  A popup window will ap-

pear and click on Paste all Contributed data to this plant.  You can 
then make any desired changes, then click on the C���� button in the 
upper right corner of the Information window.  Reminder: Since Profes-
sional Portfolios contain only pictures, Portfolio users will see only nomenclatural 
information on their Information tab when pasting plant data.

Later Changing a Plant's Attributes 

     After completing Step 4, you can change the plant’s attributes. 

1.   After selecting your authored plant, right-click on the A��������� button , then from the popup 
menu, select Edit Attributes.  Now you can add or delete selection attributes of the plant.  Clicking on 
a graphic outlined in green (or text that is in green) deletes 
the selection, clicking on a graphic that becomes outlined 
in green (or the text changes to green) adds that selection to 
the search criteria.

2.  To save your changed attributes, click on the green A��������� 
button.

3.   To change the text of the plant information, open the plant 
Information window, RIGHT click in any area, then select 
either Generate XXXX Information data from attributes or
Generate all data for this plant from attributes.

Note:  The information on the Information tab is drawn from the search at-
tributes of  a plant.  If  you modify the text on the Information tab, it will not change the search attributes.  You must use 
the process involving the graphics (as explained above) to modify the search attributes.
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Quick Tour 2 - Creating a New Species and a New Family

1. First, find a plant that has characteristics similar to the one you want to add.  Right-click on the plant 
name and from the popup menu, select Add New Plant...

2.   Delete the existing plant name in the Add a new plant window by highlighting it and then pressing 
the backspace key.

3.   In the Botanical Name field, enter the plant’s name in species format.  Be sure to always capitalize the 
genus.  If you want to enter a cultivar name, enter it in the cultivar field; otherwise continue.  In the 
Common names field, enter “My Common Name”.  A common name always begins with a capital.  
Now click on the A�� button.

Adding a New Family

     You can add a new family at the same time you add a new 
plant or add it later by editing an existing plant.  In this tour, 
we will change the family for the plant added in the previous 
steps.

1.   Right-click on the new plant’s name and, from the resulting 
popup menu, select Edit plant... In the Edit an authored plant
window, click on New family...

2.   In the Add a new plant family window, type Add a new plant family window, type Add a new plant family Horticopi in the 
Botanical name field (you only need to enter the letters pre-
ceding aceae) to create a plant family called Horticopiaceae.  In the common family name text box, aceae) to create a plant family called Horticopiaceae.  In the common family name text box, aceae
enter Horticopia, click on the A�� button, then click the U����� button.  You have now created a new 
family to which this plant now belongs.

Quick Tour 3 - Using Other Authoring Features

Hiding and Showing HORTICOPIA® Plants® Plants®

     Hiding HORTICOPIA®  plants is a useful feature when you want to suppress 
their showing on the plant list. To use this feature, you must first click on 
Tools, then Display Hidden Plants.  A check mark will appear next to the 
selection.

1.   Hide a plant by right-clicking on the HORTICOPIA®  plant name (a plant without 
the degree symbol), then, on the popup menu, click on Hide Plant (s).  The plant 
name will appear in red type to indicate that it is designated as hidden.  

2.   Show a plant by right-clicking on a hidden plant name (a plant name in red font), then, on the 
popup menu, click on Show Plant (s).  The plant name will return to black font to indicate that it 
will be shown.

3.3.    When you have finished hiding and showing plants, you then need to click on Tools, then Display When you have finished hiding and showing plants, you then need to click on Tools, then Display 
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Hidden Plants.  The check mark will disappear and your plant list will 
reflect any plants hidden or shown. 

     Display Hidden Plants.  The check mark will disapear and your plant 
list will reflect any plants hidden or shown.

     Observe that the hidden plant, the plant without the degree symbol is not without the degree symbol is not without
visible on the plant list. Verify that your authored plants appear.  Do 
this by modifying the selections in the Collections menu at the top of 
the screen.  This menu controls which collections show in the plant list.  
Go to this menu and uncheck all of the selections except for Authored 
plants.  You should now only see authored plants in the plant list.  Verify that the data and pictures 
are what was pasted in the earlier steps.   

Editing a Plant’s Name 

1.   Click on Collection then click on any active collection so so that only the Authored Plants collection 
is active. The program now displays only your authored plants.  

2.   Right-click on Hypericum calycinum ‘Species°’ (or the plant that you substituted) and then left click on 
Edit plant... to make a name change.  In the cultivar name, field type “Pretty Plant”.  Then, click on 
Update.

Quick Tour 4— Adding Text and Pictures to Existing Plants
In this Quick Tour you will learn how to add your information to the Contributed Data tab and a picture 

to the Previews tab.

1.   Double-click on a plant, such as Hypericum calycinum or one of your choice, then click on the Hypericum calycinum or one of your choice, then click on the Hypericum calycinum Contributed 
Data tab.

2.   Under the Edit menu , click on Add Authored Information.   

3.   A new Authored tab will appear under the Contributed Data tab.  Edit  any text information you wish in the 
three areas presented on the Notes side tab or copy and paste from other sources.

4.   Click on the Details side tab.  You will then be presented with four more areas in which you may 
enter or modify information.

5.     Now click on the Previews tab.  To add a picture(s) to this tab.  drag and drop picture(s) from your hard drive to the 
Preview tab.  The picture(s) will appear in the Previews tab.

        NOTE:  If  you have Garden Studio, you will also be able to edit the Custom tab of  the Information tab.  This is intended to allow you to 
edit information that you can export to Garden Studio®edit information that you can export to Garden Studio®edit information that you can export to Garden Studio .  If  you edit data on this tab, you must enter the data between the brackets there.  Any must enter the data between the brackets there.  Any must
information outside the brackets will not be exported to Garden Studio®information outside the brackets will not be exported to Garden Studio®information outside the brackets will not be exported to Garden Studio  when attempting to do so.® when attempting to do so.®

     When you author data, it will be the preferred data used when printing your documents.  If you wish 
to use another contributor, then go to the Tools menu, select Customize then select the Collections 
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tab.  You can now select the preferred data and picture source by selecting your source, then clicking 
on the Up arrow until your selection is at the top of the list.  

Quick Tour 5— Changing HORTICOPIA®  Information
In this Quick Tour you will learn how to change/add information to HORTICOPIA®   plants.  For this tour, 
we will change the common name, height and bloom color of Abelia ‘Edward Goucher’.

1.   Double click on the name, Abelia ‘Edward Goucher’, then click on the Information tab.

2.   Click on the Custom tab, then keeping between the 
brackets, change the common name from Abelia to 
Edward Goucher.

3.   Now change the Height to 2-3 feet and the Bloom 
Color to Pale pink

4.   To change the Culture Notes on the Contributed data tab. click on Edit from the menu bar then Add 
Authored Information.

5.   When the Authored tab appears, you can then enter your own Culture Notes or cut and paste from 
the Horticopia tab.
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Additional Information

In addition to this User Guide, HORTICOPIA® Professional V  provides extensive on-line information 
on using the product effectively and on solving potential problems.

Getting Assistance While You Work

The on-line help is accessed within HORTICOPIA by pressing function key F1 or by selecting the 
appropriate item from the Help menu.  The on-line help may also be viewed without starting the 
Professional V by clicking on the Start menu, then Programs, followed by Horticopia Pro, and finally 
Horticopia Pro Help (Start->Programs->Horticopia Pro->Horticopia Pro Help).  Please refer to the on-
line help before contacting our Technical Support department.

Context-sensitive Help

When you press the F1 key, the Professional V will present the help section relevant to the area you 
are currently working in.  For example, if you are working with a Layout, pressing F1 will display the 
help related to the Layout.

Tool Tips Help

The Garden Workbench® graphics, buttons and list icons have specific information that may be viewed 
by placing the mouse cursor over the graphic or button and then not moving the mouse for a couple of 
seconds.  This feature is also available with the navigation buttons displayed with the plant information 
window, the Slideshow toolbar buttons, and all other toolbar buttons.

Link to the Technical Support Web Page

Connecting to https://www.horticopia.com/support should be your first step in obtaining technical 
support and we have provided a link to our site under Help on the menu bar.  If you have an Internet 
connection, you may use this link to access the HORTICOPIA website.  Clicking Support will take you 
to  the Technical Support portion of our site and here you will find additional information concerning 
questions you have about the Professional V.  We have posted technical bulletins, FAQs, software revisions 
and a technical support form that will make it easier for us to help you. 

In Case of Problems

During program setup, you may get a message asking you to restart the computer before installation can 
be completed.  This procedure updates software libraries that may be in use by other applications. 

The Professional V is a graphics intensive application.  It works correctly on Windows Vista, XP or Professional V is a graphics intensive application.  It works correctly on Windows Vista, XP or Professional V
later systems provided these systems are configured with components that are compliant with Windows 
standards.  You may experience program crashes if your system uses drivers that are not Microsoft 
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certified.  

Graphics drivers and printer drivers are often out of date, even on brand new computers, graphics cards 
and printers.  We strongly urge you to check the respective manufacturer’s websites for driver revisions.  
On new hardware models, frequent driver revisions are not at all unusual.

The Professional V will operate on Windows NT 4.0 systems provided that all service packs (up to Service 
Pack 4) have been installed, and provided that the Windows Scripting Host is installed.  Additionally, 
Internet Explorer 5.0 or later is required.  If needed, both the Windows Scripting Host and Internet Explorer 
are included on the software CD.  When browsing for files during client setup, you may not see files 
displayed, only the containing folders.  This occurs if the version of shell.dll is an older version.  You may shell.dll is an older version.  You may shell.dll
enter the rest of the path name manually.

Although we have tested HORTICOPIA® Professional V on older Windows systems, we have noted 
resource problems occurring frequently on these older systems.  Consequently we can provide support 
for these issues only for Windows Vista, XP or later systems. 

Removing the Professional V

During the installation process, the Professional V  creates the procedures necessary for removing the Professional V  creates the procedures necessary for removing the Professional V
software.  To remove the program, do the following:

If you plan to install the Professional V on a different computer, be sure to read the information under Professional V on a different computer, be sure to read the information under Professional V
Licensing in this chapter before you remove the program.  If you remove the Professional V client software 
(in a networked environment), no special license considerations are required.

From the system Control Panel, open Add/Remove Programs.  Find   Professional V in the list and remove it.  Professional V in the list and remove it.  Professional V
If, for some reason, you wish to reinstall the HORTICOPIA® Professional V  you should always remove Professional V  you should always remove Professional V
it first.

Documents on Our Website

Several documents in Adobe® Portable Document Format (PDF) have been stored on the HORTICOPIA 
website at https://www.horticopia.com/support/Documents.html.

HORTICOPIA® Professional User Guide ( Version V) 

Garden Studio® Primer ( Version V) 

HORTICOPIA® Professional Networking Guide 

HORTICOPIA®  Quick Tips

If you do not have a compatible version of Adobe® Acrobat® Reader installed on your system, you may 
obtain a free copy from Adobe’s website at www.adobe.com.
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Horticopia, Inc. Web Site

HORTICOPIA’s web site is at https://www.horticopia.com.

There is a section devoted to technical support.  You can access this section directly at  
https://www.horticopia.com/support.  If you have any questions that aren’t answered by this User 
Guide or the on-line help, take a look at our web site for up-to-the-minute information.  You can also 
e-mail our Technical Support staff from the web page.

Contacting Horticopia, Inc.

Horticopia, Inc. provides HORTICOPIA®-specific technical support to registered users.  If you have 
problems with Windows®, your computer system, or other  software, please contact the vendors of those 
products.

Our technical support staff will be happy to assist you with any problems you experience installing or 
running the Professional V.  Before contacting Technical Supportease, please read this User Guide and 
refer to the on-line Knowledgebase at  https://www.horticopia.com/hesk/knowledgebase.php.

Complete a Help Desk ticket ---  https://www.horticopia.com/support/HelpTicket.html.  Submitting 
a Help Ticket assures you that the  history of actions taken and recommendations  made will be used by 
technical support to solve your problem.  Technical support will get back to you by the end of the next 
business day.  If you do not receive a response within that time frame, please check your spam folder

For telephone support information, go to https://www.horticopia.com/support/Policies.html.  

Please note that we only provide telephone technical support for the current version of the Professional 
V.  V.  V

Read Me File

Last minute information that was not included in the printed documentation is available in the 
README.TXT file located on the HORTICOPIA Flash Drive (HFD).  You will find any information of 
this nature at the beginning of this file.
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Copyrights and Trademarks

HORTICOPIA products are protected by copyright and trademark laws.  This chapter explains how the 
copyright laws apply to your use of the Professional V.

HORTICOPIA Trademarks

HORTICOPIA, Garden Studio, MyList and HORTICOPIA, Garden Studio, MyList and HORTICOPIA, Garden Studio, MyList Garden Workbench are registered trademarks of Horticopia, Inc.Garden Workbench are registered trademarks of Horticopia, Inc.Garden Workbench

Other Trademarks

Microsoft, Microsoft, Microsoft Windows are registered trademarks of Microsoft Corporation.  Adobe Acrobat is a registered Adobe Acrobat is a registered Adobe Acrobat
trademark of Adobe Corporation.

Copyrights

All software, pictures, data and accompanying material are copyrighted. This information is protected 
by copyright laws and international copyright treaties, as well as other intellectual property laws and 
treaties.

Copyright law will not prevent you from making reasonable use of the information and pictures contained 
on the Professional V media.  HORTICOPIA users have frequently asked us what is permissible, so we Professional V media.  HORTICOPIA users have frequently asked us what is permissible, so we Professional V
are providing some examples of both permissible and illegal use for your guidance.  These examples are 
not to be construed as any relinquishing of the copyright protection for this product.

Examples of Permissible Use

It is important to note that you cannot charge a fee or otherwise cause the recipient of any materials 
generated with HORTICOPIA products to incur an obligation to purchase materials or services.  In all cases, 
the final materials incorporating pictures or data from HORTICOPIA must be generated exclusively by your 
computer.  You may not copy, duplicate, reprint, print (except on the computer on which HORTICOPIA 
is installed), publish or otherwise use HORTICOPIA materials.

       Landscape proposals that include pictures from HORTICOPIA are a very common and popular use and is 
permitted.   However, the HORTICOPIA copyright notice must not be obliterated.  If you copy pictures 
and paste them into another application, a copyright notice must accompany the pictures and data that 
came from HORTICOPIA.

       Landscape designs may use pictures pasted from HORTICOPIA.  A copyright notice must be included 
in the design package or proposal.

       Signage used in garden centers or other retail display may be created with the Professional V.  Such signage 
may only be created and used in the garden center.  It may not be created by any service bureau or sold 
to another party.

       Information sheets generated one at a time and provided without charge are permitted.  You may not 
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charge for such information sheets nor produce them in commercial quantities.

       No e-mail of pictures or other data is allowed.  However, the Save as PDF feature on the Print Previews 
for Layouts, pictures and data allow you to create a PDF file which is suitable for e-mailing.

Garden Studio Module

If you have licensed the optional Garden Studio module, the following additional copyright terms apply 
to output generated from the Garden Studio module:

You may print and use strip tags, pot stickers and other outputs, as long as they are attached to a plant 
you are selling and do not contain HORTICOPIA pictures.

Illegal Use

You may not sell any pictures or data or products containing pictures or data derived from 
HORTICOPIA.

You may not use any pictures or data from HORTICOPIA in any brochure, plant tags, plant labels, 
newsletter, advertisement, catalog, website, or other commercial materials.

You may not make copies in commercial quantities of any printed output or other derived output of 
copyrighted materials from HORTICOPIA.  Educational users are typically allowed to make up to 25 
copies of a printedprinted output.printed output.printed

You may not display photographs or other information as a photography exhibit or any other fashion not 
incidental to your normal use.  You must not use the pictures and data in a manner where they directly 
produce income to you.

All Digital Copies are Prohibited

In no event, may any digital form of HORTICOPIA output be used except on the computer on which 
HORTICOPIA has been installed.  The End User Software License Agreement, found at the beginning 
of this User Guide, specifically prohibits such copying or duplication.  You may, for example, copy and 
paste pictures for use in another application on your computer.  You may not copy, reproduce or transmit 
such data or information.  This prohibition includes but is not limited to copying to another system on 
any network, electronic mail, website or any other digital form of transmission.  The sole exception 
is normal computer backup operations of that portion of the software installed on your system by the 
HORTICOPIA setup procedure.

You may not duplicate, reprint, print (except on the computer on which HORTICOPIA is installed), 
publish or otherwise use HORTICOPIA materials.


